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Disclaimers

. The content of this manual is subject to change without prior notice.

e  The reproduction or transfer of this manual in any form whatsoever is prohibited without the prior written
permission of the Noise Laboratory Co., Ltd. (NoiseKen).

e Although every effort has been made to ensure that the content of this manual is accurate and complete,
please contact NoiseKen if you find any unclear points, errors, omissions, or other inconsistencies.

. NoiseKen will not be liable for any damages that occur due to improper usage of this product by the
customer, failure to follow the information in this manual, or repair or modifications performed by a third
party other than NoiseKen or a party designated by NoiseKen.

. Regardless of the above, NoiseKen will not be liable for any test results obtained using this product or for its
effects on the tested equipment.

o The trademarks and company names appearing in this manual are trademarks or registered trademarks of
their respective companies. In this manual, the trademark symbol (TM) and registered symbol (R) are
omitted.

. Security Export Control System: Requirements for Exporting This NoiseKen Product
Although this product does not come under rows 1 to 15 of Appended Table 1 of the Export Trade Control
Order, it comes under the restricted goods catch-all in row 16. For this reason, you must submit an export
declaration to NoiseKen before exporting this product outside Japan or temporarily taking it outside Japan
to enable us to conduct a confirmation screening of the final customer, final application, and other details. In
the provided information, the customer will be requested to confirm that the final destination country, final
customer, final application, and other details in the export declaration comply with the restrictions in row 16
of Appended Table 1 of the Export Trade Control Order.

To ensure strict compliance with export control laws, submission of an export declaration is required. Also,
when reselling the product at a location inside or outside Japan, the repurchaser must also be notified of

above information.

* Because the above information is based on laws and regulations, it is subject to change due to revisions in the
applicable laws and regulations. For details on the control and export procedures in laws and regulations, please
contact the applicable government agency (such as the Ministry of Economy, Trade and Industry; Trade and

Economic Cooperation Bureau; Trade Control Department; Security Export Control Policy Division).



1. Software Licensing Terms

. Usage Limitations
Please use the Software for the purposes described in the instruction manuals or the
specifications. Do not use the Software for purposes other than these.

. Intended Users

Please ensure that individuals who use the Software have received the appropriate training and
practice with regard to the entire system in which the Software runs, including the usage
environment, equipment safety, and operating methods.

. Ability to Make Copies

The Software may be installed and used on multiple personal computers by individuals who are
members of the business location (factory, branch office, business office, etc.) that purchased the
Software.

. Handling of Intellectual Property Rights
The Software and the intellectual property rights including copyrights for the Software belong to
NoiseKen.

. Usage Period

The usage period designated by NoiseKen shall take effect when the installation of the Software
or the prescribed procedure for use, whichever is later, has been completed by the Customer, and
the Customer's right to use the Software shall be deemed to have expired at the end of this usage
period.

. Usage Termination Conditions

If the Customer has violated any of the provisions in this document, or has infringed on the
copyrights or other intellectual property rights of NoiseKen, NoiseKen shall have the ability to
revoke the Customer's license to use the Software.

. Procedures Upon Usage Termination
The Customer shall promptly uninstall the Software. (If other instructions have been issued by
NoiseKen, these shall be followed by the Customer.)

. Disclaimer

NoiseKen and its dealers and affiliates will not be liable for any customer damages arising from the
use of this software or for claims of damages by third parties against customers except in the case
of intentional or gross negligence by NoiseKen, its dealer, or affiliates.

. Prohibitions

The following actions are prohibited with regard to the Software.

(1) Modifications, additions, and other alterations to the functionality of the Software

(2) Any form of reverse engineering, including decompilation and disassembly, of the Software

(3) Reselling, transferring, redistributing, licensing, etc. of the Software, or the accessories
provided by NoiseKen for the Software, to third parties

(4) Storing the Software, or the information, documentation, and the like provided by NoiseKen for
the Software, on a network in a state wherein it may be conveyed to a third party

10. Handling of USB and other protection keys

The software provided by NoiseKen may require USB or other protection keys.

(1) If a protection key is included in the accessories, the protection key must be mounted in the
computer where the software is used.

(2) As a general rule, the protection key is not reissued. In the event that the protection key is
damaged or lost, please contact the NoiseKen Sales (or Repair) Division.




2. IMPORTANT SAFETY PRECAUTIONS

This software performs visualization of sound pressure in space. Important information for safe
operation when performing visualization using this software is provided below, and so be sure to read
it carefully before use.

Also, be sure to carefully read this manual and the instruction manual for each device to be used
before using this software.

1. Incorrect or careless operation could result in a fatal injury.
2. Avoid use in locations exposed to high humidity and large amounts of dust.

3. When making connections, electric shock can occur due to contact with the supply
voltage, and so before performing any connection work, be sure to turn off the power
to the each device, and check that no power is flowing.

4. Do not turn off the power to the each device or disconnect any cables while this
software is running. This could cause PC operation to become unstable or the OS to
malfunction. Be sure to always exit this software before turning off the power to the
each device.

5. If the coaxial cable is bent too hard, there is a possibility of breaking the wire. Handle
the coaxial cable with care.




3. ltem Check List

Before starting use, check that the parts and accessories below are
included with the product.

C D

A: Sound pressure sensor (Microphone)

Main part ................................................................ 1

Sensor cover (ye||ow/red/b|ue) ................................... each 1

Data Sheet: -  rrrrrmrrrrae 1
B: Microphone power supply

Main part ................................................................ 1

AC adapter ............................................................. 1

ManUAl - - e 1 set

Battery ................................................................... 2
C: Web camera

Main part ................................................................ 1

Warranty ................................................................ 1
D: USB protect key ............................................................. 1
E: BNC coaxial cable (3 m) -« rrerrermrmm 1
F: BNC-N coaxial cable (1.5 m) -« e oeeeememmmiiii, 1
G: LAN cable (2 m) ............................................................. 1
H: USB extension cable (2 m) -« e 1
I: Camera tripod

Main part ................................................................ 1

Storage bag ............................................................ 1

IMANUAL - rrrrrrrrrrere e e 1
J: Installation DVD (EPS-028V2) ---+vvueremnermmieiiiiiiiii, 1
K: Japanese Quick Start GUide «----+-rerreerrrmmen 1
L: English Quick Start Guide:«-+««+-xrremrrermmrmmi 1
M: Storage COSE ++rrrrrrrrnnnanaaaasasteetaetanaaaaa et 1

* The key of C, J, K and L are included in the upgrade version.
* The key of D, J, K and L are included in the secondary license version.
* The warranty for A, D, E, F, J and M is in accordance with our warranty policy.




4. Introduction

Thank you for purchasing the EPS-02Sv2 Sound Source Visualization System. Before
using the EPS-02Sv2, be sure to carefully read this manual to ensure that you maximize
its performance when operating the EPS-02Sv2.

® This User Guide is provided to ensure that people who follow the operating procedures

and safety information can safely use the EPS-02Sv2 and maximize its performance.

® Place this User Guide in a location where it is easily accessible whenever operating the
EPS-02Sv2.

4—1.

Features

Enabling visualization of sound pressure in space

A sound pressure sensor is used to perform frequency analysis with a spectrum analyzer and
to map to the emission location of the actual image.

The emission location is mapped relative to the sensor location recognized using the web
camera.

An area of up to 64 blocks x 48 blocks can be measured.

A superimposed image of the measurement strength distribution diagram and web camera
image are displayed for enabling easy identification of the emission source. The density of
the strength distribution and frequency range can be specified.

Measured results can be saved to a file, and the content of the measurement results and file
can be compared for enabling visualization of the effects of corrective actions.

Because the measurement sensor can be moved not by a device like a positioner but by

hand, easy measurement is possible even in cramped spaces, outdoors, and other
difficult-to-access locations.
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6. Overview

6—1. Notation Used in This Guide

The marks used in this guide and their meanings are provided below.

©

Provides an additional explanation.

0

Indicates a location for further reference.

Indicates a setting restriction.

/N

Indicates that you must check before usage.

6—2. EPS-02Sv2 Features

* Measurement sensor is detected from the image for recognizing the measurement

location

The measurement object and measurement sensor are captured by a camera, and the
measurement sensor is found within the image for identifying the measurement location. The
recognized measurement location is a relative location within the camera image.

Any user-selected color can be specified for the measurement sensor. However, selecting a
color with the same tone as the background color will result in a reduced rate of recognition
and even mistaken recognition in certain cases.

The measurable range is the area shown in the camera, but it is restricted to a range that can
be recognized by the measurement sensor.

*  Automatic control by software

Measurement sensor recognition from the camera image and control of the spectrum
analyzer are performed automatically. The measurement results can be output as a CSV file,
and the image can be output in BMP format.

Also, because the software is a Microsoft Windows application, it provides an
easily-accessible interface that uses mouse operations while viewing the screen.

*  Visual display of measurement results

The measurement strength distribution and camera image are displayed as a superimposed
image on the computer screen. Also, the mouse pointer in the image can be used to confirm
measurement results for any selected position.

In addition, an interpolation view of the surrounding strength can be used to provide easier
assessment of the generation points.

*  Full emission analysis function for measurement points

Data can be collected for the entire measurement frequency range generated from the
measured object in a single measurement. The emission map for each frequency band is
also redisplayed by simply specifying the frequency band.




6.0Overview

6—3. Measurement Principle

The EPS-02Sv2 system performs two main operations for enabling visualization of the sound. First,
it performs image recognition that identifies the measurement sensor location from the recording
image. Second, it provides a color-coded distribution on the image indicating the strength of the
signals detected by the measurement sensor.

In image recognition, 640 x 480 pixel video from the camera is monitored in real time, and a
specific color only is extracted based on the specified parameters for "hue", "brightness", and
"saturation”. By finding the focal point of the area with the specific color, the location of the specific
object (measurement sensor) can be found in the image.

If an object with the same color as the specified color, but that is not the measurement sensor,
appears in the image, the measurement sensor location cannot be recognized correctly because the
focal point of all objects of this color is calculated. Therefore, the parameter settings for "hue",
"brightness”, and "saturation" that are used to detect the measurement sensor, the brightness and
light exposure in the recording location, and selection of the lighting are important factors. Also, the
cover of the measurement sensor must be adjusted based on the color of the measurement object.

A spectrum analyzer is used as the measuring instrument for enabling measurement of the sound
pressure level. The spectrum import count and frequency range vary depending on the measurement
sensor and measuring instrument. The measurement data is mapped to a position specified by image
recognition. The method of capturing data at the same position can be selected from MAX HOLD,
PEAK HOLD, FREE RUN, and SINGLE.

After measurement is completed, the frequency range that you want to view can be selected for

creating a strength distribution combined with the image.



7. System Configuration Diagram

7—1. System Configuration Diagram

®

®

USB cable LAN cable i

y

BNC(P)-N(P)
coaxial cable

BNC(P)-BNC(P)

coaxial cable
@ Control PC

This controls the various devices and conducts sound pressure measurement.

@ Web camera
This captures the image of measurement object.

@ Sound pressure sensor
Measures sound pressure and outputs analog signals. This sensor is powered via the INPUT
terminal of the microphone power supply. A certain color must be added to the sensor so that the
PC can recognize the sensor position. Attach an included sensor cover to the sensor before use.

@ Microphone power supply
Connect the sound pressure sensor to “INPUT CH1” using the included BNC cable, and connect
a spectrum analyzer to “OUTPUT CH1” using the included BNC-N cable.
Make sure that INPUT and OUTPUT connections are correct.
Be sure to take into account wrong connections may damage the equipment.
Set the GAIN changeover switch to 0 dB (default). If the switch is set to 20 dB, make sure that the
setting does not exceed the maximum input of the spectrum analyzer

® Spectrum analyzer

The spectrum analyzer is connected to the PC using the supplied LAN cable.

Support is provided for some spectrum analyzers described in [11—3.Supported Spectrum
Analyzers] on page 36. Please consult with NoiseKen for use of spectrum analyzers that are not
supported.




7.System Configuration Diagram

7—2. Functions of Each Device

@ Control PC
This enables running of system control software. This software imports images from the web
camera, identifies the measurement sensor within the image, and finds its location. After
frequency analysis is performed by the spectrum analyzer, the control PC receives the
measurement results and maps them to that location.

@ Web camera
This is a general-purpose web camera. The image of measurement object is captured and
transferred to the PC. The web camera is connected to the PC by a USB cable. If necessary, the
connection can be extended by a USB extension cable.

@ Sound pressure sensor
This has a built-in microphone to measure sound pressure.
A special cover is attached to the sensor before use to improve the recognition rate.
The cover is made of windshield sponge, which reduces wind noise.

@ Microphone power supply
This supplies power to the sound pressure sensor connected to the INPUT terminal and outputs
analog signal from the OUTPUT terminal.
By using the GAIN changeover switch above the OUTPUT terminal, signals are amplified to 20
dB. For the EPS-02Sv2, the switch must be set to 0 dB (default).
Since the spectrum analyzer is highly sensitive, amplified signals are usually not needed.
If the switch is set to 20 dB, before use, make sure that the setting does not exceed the maximum
input of the spectrum analyzer.

It is powered by the AC adapter or batteries.

- Switch [ON]: Supplies power to the sound pressure sensor connected to the INPUT terminal
and outputs signals from the OUTPUT terminal.The BATT LED is not lit, which is the normal
status.

- Switch [OFF]: Stops supplying power to the sound pressure sensor and outputting signals from
the OUTPUT terminal.

- Switch [BATT]: Checks whether the voltage of the AC adapter or the batteries are normal. If it is
normal, the BATT LED is lit.

® Spectrum analyzer
This performs frequency analysis of the signals from the measurement sensor and sends the
spectrum data to the PC.

10



8. Preparation

/!\ CAUTION

In environments exposed to extremely large amounts of external noise, the equipment may be unable
to realize its maximum performance.

Even when indoors, the equipment can be affected by an air conditioner and other electronic devices.
During measurement, try to minimize external noise. Depending on the PC, its cooling fan may
generate large noise not suitable for measurement.

8—1. System Backup

NoiseKen provides an optional service (additional charges apply) for installing the EPS-02Sv2
program in your PC before providing the program, but if the program is erased, install it from the
supplied DVD. Copy the content of the DVD to a hard disk, removable disk, or other location and
store it there in case of loss.

The CD included with the web camera mounted on the PC is provided to the customer, but it is also
recommended that you create a backup of this CD in the same way and store it in a separate location
from the original disk.

For details of setup, see "10. Setup" (P34).

8—2. System Connections

@ Connect the web camera to the PC using the USB cable. Any commercially-available USB cable
can be used, but it must be a cable that supports the USB 2.0 standards. Be aware that the USB
2.0 standards limit the cables to a maximum of 1 extension and maximum length of 5 m.

@ The spectrum analyzer and PC are connected by a GPIB or LAN cable. A commercially-available
cable can be used for the LAN cable. Use a one-to-one local connection without passing through
the site LAN or hub.

@ Attach a sensor cover to the sound pressure sensor.
Connect the sound pressure sensor and the INPUT CH1 terminal of the microphone power
supply using the included BNC cable.
A commercially-available 50 Q coaxial cable can be used for the BNC cable.

@ Connect the spectrum analyzer and the OUTPUT CH1 terminal using the included BNC-N cable.
Make sure that INPUT and OUTPUT connections are correct.
A commercially-available 50 Q coaxial cable can be used for the BNC-N cable.

11




9. Operation Procedure

9—1. Starting and Exiting the Software

Starting the Software
To start the software, double-click the EPS-02Sv2 shortcut icon on the desktop.

Double-click ]

EPS-025v2

Screen displayed immediately after the software is started

Exiting the Software
To exit the software, click the close button on the right end of the title bar or click Exit from the File

menu.
Because the software cannot be closed during measurement, finish measurement before exiting

the software. _

._J New Measurement Ctri+N

=y
— = | Open... Ctri+=0O
)
Close
\-/
\m R
2 Chllsersy..\Wiews3 edf
3 ChUsersh.. \View edf ! CliCk I
4 Chillsersy. \Wiewl . edf

( Exit
i
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9.Operation Procedure

9—2. Image Recognition Settings

Image Recognition Setting Dialog Box
To open the Image Recognition Setting dialog box, click Image Recognition Setting from the

Set menu.

Image Recognition Settins

Camera Setting

Device Name [ Logicool HD Pra Weboam G920 - L)

160

Saturation (3)

Device Filters Other Settings
Walue (W) EE 120
| Gancel

Image Recognition Setting dialog box

@ Adjust the camera position so that the measurement object can be captured by the camera.
Take the following conditions into account during adjustment. Changing camera properties or

adjusting the lighting may be required depending on the circumstances.
- Sufficient brightness is provided so that the measurement object and the measurement

sensor can be fully recognized.
- There is no object whose color is similar to that of the measurement sensor.

Device Name
Camera names are displayed in the Device Name list. If multiple cameras are connected, select

the camera to be used from the device name list.

Select a camera
Camera Setting

Device Name C[Logicool HD Pro Webcam G820 . ~]

W W D——
a5 x FI&

LOR KCO0T v » PRSI
Integrated Webcam

Device Filters

13



9.0Operation Procedure

Device Filters

To open the Webcam Properties dialog box, click the Device Filters button.
In the dialog box, the camera properties, such as zoom, white balance, and anti-flicker, can be set.

Camera Setting

Device Name HD Pro Webcam C920
Device Filters Other Settings
Device Filter Properties bed Device Filter Properties
Video Proc Amp | m
Ria Auto
Brightness ]
5 Zoom @ 100
Confrast [ ] 128
Focus a5

o . Exposure =
Saturation 'l White balance 4—'
Sharpness ] =] 5

S Pan 1 0
White Balance 4799 Tit 1 o |
Backlight Comp | i

Gain T Low Light

- ™ Compensation b
ColorEnable Powerline Frequency | 60Hz Default

{Anti Flicker)
Default
Cancl > Cancel | | Losh

L

Anti Flicker

Video Proc Amp screen

Camera Control screen

White balance is a function to perform color correction so that a white object appears white. If the
light source, such as sunlight, light bulb, or fluorescent, makes the white object look bluish or

>  White balance

reddish, adjust white balance.
»  Anti Flicker

Anti Flicker is a function to reduce flicker in images.
» Zoom

Zooming may not be possible depending on the model, driver, or color space / compression
settings. Refer to “Other Settings” on page 15 for the color space / compression.

camera.

The Properties screen may vary depending on the model or driver version of the connected




9.Operation Procedure

Other Settings
To open the Other Settings dialog box, click the Other Settings button.
In the dialog box, the color space / compression and camera processing can be set.

Camera Setting

Dewice Mame HD Pro Webcam G920

Device Filters Other Settines

 Som
(oo >

Crther Settings >

Colar Space / Compression

(1) MJPG (Recommended) v

Camera proceszing zettings

(2) [«]High speed processing

Ik Cancel

Other Settings dialog box

(1) Color Space / Compression

The color space / compression of the camera can be changed. If the camera is not working
properly, changing it may improve the situation. The first item in the list is the recommended
method.

(2) High speed processing

Speed up camera processing. If the camera is not working properly, unchecking the checkbox
may improve the situation.

15



9.0Operation Procedure

Image Recognition Setting
Adjust the three parameters, Hue, Saturation, and Value, in the Image Processing Setting so

that the color of the sound pressure sensor can be recognized. The binarized image on the right
side can be changed by moving the slider of each parameter.

Hue: Sets the hue, such as red, blue, or yellow
Saturation: Sets the intensity and purity of a hue
Value: Sets the lightness of a color.

Image Processing Setting

Hue (H) = S 40
8
Saturation (5] 160
L
Value (W) EE— 120

Adjust the parameters until the sound pressure sensor is recognized as a circle and no other object
is recognized. If there is any object whose color is similar to that of the sensor in the background,
hide the object or change the color of the sensor.

Once the sensor is recognized as a circle, click OK to complete adjustment.

&

Desirable recognition state Not desirable recognition state

The shape of the sensor is almost circular. The shape of the sensor is not circular.
There are no recognized areas in the There are recognized areas in the
background. background.

@ Procedure for successful sensor recognition setting

1. Set the Saturation and Value to 0.

2. Adjust the Hue so that the sensor is most clearly recognized.

3. Increase the Saturation gradually to remove other recognized areas around the sensor.
Do not increase the Saturation excessively to prevent the recognized sensor area from
being impaired.

4. Increase the Value in the same manner.

5. Finally, move the sensor outside of the camera view, and make sure that there is no
object to be recognized.

If any other object is recognized, repeat steps 3 and 4.

When the mal-recognition is not solved even if steps 3 and 4 are repeated, start over
from step 1.

16



9.Operation Procedure

9—3. Communication Settings

Communication Settings Dialog Box

To open the Communication Settings dialog box, click Communication Settings from the Set
menu.

In this dialog box, a remote-controlled spectrum analyzer can be set up.

| Communication Settings

Equipment Name IFSU

Interface L&k

Communication Settings... IF Address 192 . 168, 99 .

| Cahcel ‘

Communication Settings dialog

Equipment Name
Select the equipment name of the connected spectrum analyzer.
The following driver is available as standard options: FSV and FSV3000. Customized spectrum
analyzer drivers are also included in this list.

Equipment Name |F3%W -

FSV3000 |

Q If the Equipment Name list is blank, no spectrum analyzer driver may exist. Check to see that
spectrum analyzer drivers (*.sads) are stored in the folder where the EPS-02Sv2 executable file is
stored (C:¥Program Files (x86)¥NoiseKen¥EPS-02Sv2, under normal conditions).

@) EPS-02R.ico 9/9/201510:06 PM lcon 212 KB
@) EPS-025v2.exe 3/8/2017 5:20 PM Apphcation 4,129 KE
|| FSV.sads 3/2/2017 4:41 PM SADS File 1,806 KB

| | F5V3000.5ads

Q When NI-VISA (National Instruments) has not been installed, the Equipment Name list is blank

even if spectrum analyzer drivers exist. In such cases, install NI-VISA according to “10—
3.Installing the Software” in page 35.
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9.0Operation Procedure

Interface
Select LAN as the interface and set the IP address. For how to set the IP address, see “10—
2.Network Address Settings” in page 34.

Interface Lt -
GP-IE |
IP Address 192 168 . 99 . 100

9—4. New Measurement (Setting Measurement Conditions)

View Window
To open a View window, click New Measurement from the File menu or click the New
Measurement button on the toolbar.
Whenever a View window is newly opened, it is numbered as follows: View1, View2, View3 ...
These names can be changed freely when the file is saved after measurement.
Before starting measurement, set an image division size, properties for the spectrum analyzer, and
other conditions in the View window.

: File Set Help

WEEIEELEE

| (& open.. Ctrl+0

Close

Exit
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9.Operation Procedure

i =l

EEEEER] 1o @

078
067
066
044
033
022
AR

Condition |

= Image Divizion Size
[ il [20 v| pixel
. i Data Record
[Tl Gampletion Matice
1 [PEAK HOLD  +|
: i Measurement Time Setting.
[ Time Setting ogo ' =

@ Z-weighting
fi-weighting
C-weighting

Frequency
STHRT 2000

= |Hz v]
stop 2000 = [kHz

Spectrum finalyzer
Fa Set

Microphone Senzitivity  GAIN
-8260 1= 4B oo = de
Enter the GAIN value get for the

microphone power supply in the GAIN
field. (0 dB is recommende

View window (before measurement)

@ If a web camera or USB protect key is not connected, new measurement is not possible.

Condition Tab

In the Condition tab, set the image division size, properties for the spectrum analyzer, and other
conditions.

Condition items can be set only before measurement. After completion of measurement, all items
are displayed but cannot be changed.

Ciondition Condition | Map Wiew | Comment
Image Division Size Image Divizion Size
a0 - pixel 20 pixel
Data Fecord o Data Record -
Completion Motice @ Z-weighting Completion Motice 'S Z—wmlghtllng
— fi-meighting A-weighting
FEAK HOLD ~ C-weighting FEAK HOLD C-weighting
Measurement Time Setting Measurement Time Setting
Time Setting 000 =l Time Setting | 0.00 =
Frequency Frequency
START 2000 = (4 START |20.00 | |Hz
STOFR 2000 = |kHz = STOP 20,00 | |kHz
Spectrum Analyzer Spectrum fnalvzer
F3W Set FSw Set
Microphone Sengitivity  GAIN Microphone Senzitivity  GAIN
-3260 = 4B 0.0 = 4B -3260 | 4B 0.0 ~ 4B
Enter the GAIM value set for the Enter the GAIN value set for the
microphone power supply in the GAIN microphone power supply in the GAIN
field. {0 dB iz recommended field. (0 dB iz recommended
Conditions (before measurement) Conditions (after measurement)
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9.0peration Procedure

Image Division Size
Set the division size by which a camera image of 640 x 480 pixels is divided.
The image division size can be selected from 10 pixels (H: 64 x V: 48 squares), 16 pixels (H: 40 x
V: 30 squares), 20 pixels (H: 32 x V: 24 squares), 32 pixels (H: 20 x V: 15 squares), 40 pixels (H:
16 x V: 12 squares), 80 pixels (H: 8 x V: 6 squares), or 160 pixels (H: 4 x V: 3 squares).
Select 20 or 32 pixels normally.

Imaee Divizion Size

pixel

Image division size: 10 pixels Image division size: 160 pixels

Capturing
If the checkbox for Completion Notice is checked, Complete is displayed when all image divisions
are completely color-coded during measurement.

049 @ _||__| B4 .21
078 f3.49
067 = £2.76

056 o 5203 . |COME
044 121
na3 G058
0.23 i R E
0.1 5913
Before completion of measuring all divisions After completion of measuring all image divisions
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9.Operation Procedure

How to store spectrum data at the same measurement point (the same square of the grid) can be
selected from SINGLE, FREE RUN, PEAK HOLD, or MAX HOLD.

Data Record
[T ompletion Motice

FEAK HOLD -

SINGLE

SINGLE Performs measurement only one time.
FREE RUN Always overwrites the data.
Compares the maximum values of the spectrum
PEAK HOLD | waveforms, and overwrites the retained value if it is not
the largest.
Compares the maximum values of the spectrum
MAX HOLD waveforms on a point basis, and overwrites the

retained values if it is not the largest.

One of Z-weighting, A-weighting, and C-weighting can be selected.

@ F-weightineg
O A-wmeighting
O Cewmeighting

Z-weighting

Can measure sound pressure levels without frequency
weighting.

A-weighting

Frequency weighting in accordance with the
characteristics of human auditory sense

C-weighting

Frequency weighting that is closer to a flat frequency
response than A-weighing

Measurement Time Setting
If the checkbox for Measurement Time Setting is checked, when the time in seconds specified for
the image division has elapsed during measurement, Time Exceeded is displayed. In addition, the
circle that indicates the sensor position blinks until the time specified has elapsed.

If moving from the image division before the specified time in seconds has elapsed, the elapsed

time is reset to 0.

Meazurement Time Settineg

ime Setting | 6000 = =

{'1'_ ;.:'.:':I

481 4720

48.00 4712

4780 | 4707

dB

4778 I 47.00 4

e 45,94

4755 4RAT Time Exceeded
e ;-
Before the time specified has elapsed After the time specified has elapsed
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9.0Operation Procedure

If the method of capturing data is PEAK HOLD or MAX HOLD, the measurement results are not
applied until the specified time in seconds has elapsed. After the specified time in seconds has
elapsed, the operation becomes the same as when the checkbox is unchecked.

Frequency

The measurable frequency range depends on the spectrum analyzer and sound pressure sensor.
The frequency unit can be selected from Hz, kHz, MHz, and GHz.

Frequency
START 2000 = fp o Hz-
2000 = - Hz
STOP ! [kHz I

Spectrum Analyzer
To configure advanced settings for the spectrum analyzer, click the Set button next to the
equipment name of the analyzer to open the Property dialog box.
For details of each item, refer to the instruction manual for the spectrum analyzer.

Rezolution Bandwidth
Spectrum Analyzer

Fov St ) Viden Bandwidth | AUTO v
Attenuator AUTO -

Reference Level 104 dB

Detectar  |Positive Peak  +|

Preamplifier QFF

Coupling Do

Sweep Points G001

Trace Mode | Clear Write |

Sweep Count 1

Ok ‘ | Gancel l
Wer.2.00

Q ltems shown in the Property dialog box may vary depending on the selected spectrum

analyzer driver.
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9.Operation Procedure

Microphone Sensitivity
Enter the microphone’s own sensitivity value into the Microphone Sensitivity field.
Enter the exact value of [Sensitivity: —xx.x dB] shown in the data sheet (graph sheet) included
with the sound pressure sensor.

Microphone Sensit ity
—3260 = 4B

GAIN
Enter the GAIN value set for the microphone power supply into the GAIN field.

Since the spectrum analyzer is highly sensitive, generally there is no problem when 0 dB is set.

GAIN
0.on ~ dB
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9.0Operation Procedure

9—5. New Measurement (Performing Measurement)

Performing Measurement
To start measurement, click the START button in the upper right of the View window. During
measurement, the PAUSE and STOP buttons are enabled.
To suspend measurement, click the PAUSE button to suspend measurement, and to finish
measurement, the STOP button.
After completion of measurement, all buttons are disabled. When performing measurement again,
click New Measurement from the File menu or click the New Measurement button on the toolbar.

| PAUSE | !STOP |
o o]

Before measurement During measurement After measurement

A

Once measurement is started, the Map View and Comment tabs appear next to the Condition tab.
In the Map View tab, during measurement, Intensity Distribution mode can be switched between
OVERALL and PEAK, and Transmittance can be changed, and after completion of measurement,
all items can be set. ltems in the Comment tab can be set even during measurement.

During measurement, points (squares in the grid) measured are color-coded according to the
setting of the overall or peak value in the Map View tab and are overlaid on the camera image. In
addition, the spectrum data measured by the spectrum analyzer is displayed in the spectrum graph
area located in the lower part of the View window, on a point-by-point basis.

- "
] viewa [ =] 22

417 ‘j|z|

9050
46.82
4315
7947
7580
123
[1:237

;Cunditiun: Map Yiew Cummenlr:

Intensity Distribution
Auto Distribution
Interpolation
OVERALL

Q@ PEAK

Transmittance
U

0%

MARKER 1250 kHz PEAK  9529dB
Frequency Range

Specified Frequency
2000 Hz - 2000 kHz

Feak Search

16.00 k 2000 k

@ Move the sound pressure sensor while keeping the same direction and maintaining a constant
distance from the object to be measured.
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9.Operation Procedure

The EPS-02Sv2 software sends a sweep start command to the spectrum analyzer immediately
after the sensor is recognized. After completion of sweeping, the software recognizes the sensor
position again, and only when the sensor is found at the same point (position) where it was placed
at the start of the analyzer sweeping, the spectrum data is stored.

If the sensor is moved quickly, the point at the start of sweeping differs from that at the completion
of sweeping, and as a result, measurement data is not stored. For spectrum analyzers with slow
response speed, move the sensor more slowly.

If the sensor is not recognized or other object is falsely recognized, reconfigure the image
recognition setting. Click Image Recognition Setting from the Set menu to change the setting.
Please note that it is possible during measurement.

The [OVERALL] field at the top right of the spectrum graph displays the overall value measured by
the spectrum analyzer. The overall value is exactly the value that was measured by the spectrum
analyzer without any modification made on the PC.

&>| If MAX HOLD is selected for Data Record:

MAX HOLD processing is carried out on the PC against the trace data acquired from the
spectrum analyzer to the PC, to create a spectrum graph.

OVERALL displayed at the top right of the spectrum graph switches to OVERALL (for
reference)

The OVERALL (for reference) field displays the largest of all overall values that were
measured by the spectrum analyzer at the point.

Deleting Measurement Data
Stored measurement data can be deleted on a point-by-point basis.
When data to be deleted is right-clicked during measurement, the Delete menu will appear. Click
this menu to delete the measurement data for the corresponding point.

Delete

= 3

Before deleting data After deleting data

@ Data can be deleted only during measurement and cannot be deleted after completion of
measurement.
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9.0peration Procedure

Recapturing Camera Image
If the STOP button is clicked after completion of measurement, the camera image switches from
video to still image. If the still camera image includes an unnecessary object, such as the sensor,
the camera image can be recaptured.
Click Recapture Camera Image from the Window menu. The still image will switch to video and

the following message will be displayed.

Help

Mew Window
Cascade
Tile

Arrange lcons

(V] 1views

Window...

Click

Click on the OK button and the program will capture the camera
picture.

For canceling a capture of the image currently shown, click on
the cancel button.

T YT

Clicking the OK button switches the camera image from video to still image to capture a new
camera image. To return the original camera image, click the Cancel button.

Before recapturing

After recapturing

Q Recapturing is possible as many times as needed before the file is saved.

Note that recapturing is not possible once the file is saved.
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9.Operation Procedure

9—6. Measurement Data Analysis

Measurement Data

After completion of measurement, a square pointer [d] will be displayed on the camera image.
Dragging this pointer to the desired point can display the spectrum data at the relevant point.

The pointer automatically moves to the highest level point immediately after measurement is
complete or the file is opened.

MJ Viewl

ol o e

MARKER 1250 kHz

FEAK

9835
A6 g
a402
9136 4
it
2603
2336
a070

Oondltlon Map View :.C.ommen.t-;
Intensity Distribution
[¥] Awta Distribution St
[ Interpalation
OVERALL
@ PEAK

| Transmittance

5
0%

10201 dB
Frequency Ranee

| Specified Frequency
2000 Hz - 2000 kHz

Paak Search

In the Condition tab, the conditions configured before measurement can be checked. The
representation of measurement data can be changed in the Map View tab. In the Comment tab,
measurement information and other comments can be entered.

Ganditian | Map Wiew | Comment

Image Divizion Size

20 pixel
Data Record -
Completion Motice Z—wm_ghtl.ng
A-weighting
FEAK HOLD C-weighting
Measurement Time Setting
Time Setting | 0.00 s
Frequency
START | 2000 ~ |He
STOP 2000 kHz
Spectrum fnalyzer
Fsv | set |
Microphone Sengitivity  GAIN
-3250 ~ dB n.on ~ dB

Enter the GAIMN walue set for the
microphone power supply in the GAIN
field. (0 dB 1= recommended)

Condition tab

Map Wiew | Comment

IéDndl‘tan Map Wiew :_.éomment-? Condition

Intenzity Distribution Measurement Information

[¥] Auta Distribution

Model
[ Interpolation
Serial Mo.
(I OVERALL
@ PEAK Day
Tranzmittance Temperature deg
I_,l Humidity %
K
e
Frequency Fanee
["] Specified Frequency Set
20.00 Hz - 2000 kHz
| Peak Search | 1 )

Map View tab Comment tab
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9.0Operation Procedure

Auto Distribution
When the Auto Distribution checkbox is checked, the color map is made according to automatic
distribution between the highest and lowest intensity. When OVERALL is chosen, the maximum
and minimum overall values are displayed as color-coded images. When PEAK is selected, the
maximum and minimum peak values are displayed as color-coded images.

Intengity Distribution
(1] fwata Distribution Set

[T terpolation

(O OVERALL
@ PEAK

To change the Upper/Lower Value to desired values, uncheck the Auto Distribution checkbox
and click the Set button. The upper/lower value settings will be reflected to the map data color bar.

Intensity Distribution
[ Auto Distribution et ]

(T OWERALL

@ PEAK

84:29 Upper Value?

dB v i
7057 £ Loveer Walue @ dBulf

| | cancel |
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9.Operation Procedure

Interpolation

When the Interpolation checkbox is checked, the map data image is smoothly displayed by
interpolation of the boundaries between divisions.

Intensity Distribution
Auto Distribution Set
Tnterpolation

) OVERALL
@ PEAK

Without interpolation With interpolation

Transmittance
The transparency of the color map can be changed.
When Transmittance is set to 100%, the map is invisible and only the camera image will be

displayed. When Transmittance is set to 0%, the camera image is invisible at the points where
data exist.

Tranzmittance
m

W

0%

Transmittance: 0% Transmittance: 100%
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9.0Operation Procedure

Frequency Range

When PEAK is chosen for Intensity Distribution, if the Specified Frequency checkbox is
checked under Frequency Range, the map is color-coded not using the peak values of the whole
frequency range but using those of the specified frequency range, and the relevant blue zone band
is displayed in the spectrum graph.

This zone band can be moved to the right or left by dragging it, and thereby the color-map on the
camera image changes. In addition, the width of the zone band can be changed by dragging an
end of the band to the right or left.

PEAK  4086dE OWERALL 10208 dB

Frequency Ranee

| Specified Frequency Set

500 kHz - 10.00 kHz

| Peak. Search |

1201k 16.00 k. 2000k

Clicking the Set button opens the Frequency Setting dialog box, where the frequency range for
the zone band can be directly entered.

| Frequency Setting . Llhéi,
Frequency Fanee | S

V| Specified Frequency @ START: B0 |kHz vl
500 kHz - 1000 kHz m STOP: 1000 ke |

| Peak. Search |

|_ ol | | Cancel |

Q If OVERALL is chosen, the checkbox for Specified Frequency cannot be checked. Please
note if the checkbox for Specified Frequency is checked, PEAK cannot be switched to
OVERALL.

Clicking the Peak Search button moves the pointer to the point with the maximum peak value in
the map. And then, the red line moves to the maximum peak value of the spectrum graph. If the
zone band is displayed, the pointer moves to the point with the maximum peak value in the zone
band. If OVERALL is chosen for Intensity Distribution, the pointer moves to the point with the
maximum overall value in the map.
MARKER 1250 kHz PEAK 10201dE OVWERALL 10208 4B
Fraquency Fange

Specified Frequency Set

20.00 Hz - 2000 kHz

1201k 16.00 k 0.00 k
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9.Operation Procedure

Measurement Information
The measurement date is automatically input in the Day field. For other items, enter information

freely. If no information is required, leave the field blank.

Measurement Information

Model

Serial Mo.

Day

Temperature deg
Humidity ]

Memo
Any information about measurement can be entered freely. In the Memo field, there is no limit of

the number of characters.

tema
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9.0Operation Procedure

Matching Map View Data

The same setting can be applied to all maps on the View windows that are currently open.

When Match Map View Data in the Window menu is clicked, the map view settings of the last
active View window will be applied to all of open View windows. The settings to be applied include
Upper/Lower Value, Interpolation, OVERALL/PEAK, and Transmittance. Specified Frequency
is also applied if the START and STOP frequencies are the same among Windows. Use this

function to compare measurement data before and after corrective actions.

2 viewt

Recapture Camera Image

Match Map View Data

HNew Window
Cascade
Tile
Arrange Icons
1 Viewd

v || 2 view2

Window..,

= @ [®] | viewz

=l

, WARKER 10SDKkH:  PEAK 570448

2 viewt

1600k 2000k

5786
5437
5089
4741
4392
ang
3635
3347

Gandition | Map View | Camment |

YITnterpolation

OVERALL
@ PEAK

Transmittance
8]
0%

MARKER  1050kHz  PEAK 974508
Frequency Range

Yl Specitied Frequency | Set |

450 kHe - 1109 kHe

OVERALL 97458

© GVERALL
PEAK

Transmittance
B,

0%

Frequency Ranes

Specified Frequency
2000 Hz - 2000 kHe

Peak Search

[

o MARKER 10S0KH: PEAK 57044
o

Candition | Map Vien | Gamment|

1600k 2000k

Intensity Distribution

7] duto Distribution
7] Interpolation
OVERALL
9 PEAK

MARKER _1050kH: _ PEAK  5705dB
s

]specified Frequency | Sat |
450 kHe - 1100 kHz

[ Pock Search

After matching map view data
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1800k

OVERALL 874548

2000k

Tranemitiance

Frequency Ranee

7] Specified Frequency ‘ Set ‘

5780
5497
6080
24
4392
044
3695

OVERALL
@ PEAK

450 KHz - 1109 kHz



9.Operation Procedure

Exporting Measurement Data

Measurement data can be exported to an external file.
Select Export from the File menu, and choose one from Map Data, Spectrum Data, and All

Spectrum Data. The Save As dialog box will appear.

S5et  Window Help

__j Mew Measurement

Lj Open...

Close
[H Save

Save As..
Export

1 Viewd, edf
2 Views.edf
3 View2.edf

4 Viewl.edf

Exit

Ctrl+N
Ctrl+0

Cirl=5

| Map Data...
Spectrum Data..,
All Spectrum Data,

In Save as type on the Save As dialog box, either CSV File or Bitmap File can be specified.

l @ Save As

@uv| « NoiseKen » EPS-0252

Organize « Mew folder

Meiseken *

4 EPS-02EMFvZ
EP5-02Ev2
EP5-02H
EP5-02Hv2

) EPS-025v2

\ EPS-03EMRv2
EP5-03Ev2

l EPS-03Hw2

./ Perflogs

MName

| =TT

[ #2 ||| Search £ps-c25.2 o
- @

Type

iz

Date modified

No items match your search,

I Program Files = |0y

File name:  Viewl_map.csv

1T | b

Save as type: |IMap

wlap Data CSV File (*.csv)
Iap Data Bitmap File (" kmp)

Uz - Il‘lii!“-

4/ Hide Folders

FTTCET ]

» Map Data

CSV file: The peak values for each measurement point are exported.
BMP file: The map data image pasted on the camera image is exported.

» Spectrum Data

CSV file: The spectrum waveform data for the point indicated by the pointer [ is exported.
BMP file: The spectrum graph image for the point indicated by the pointer [d] is exported.

»  All Spectrum Data

CSV file: The spectrum data for all measurement points are exported.
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10.Setup

10—1.Important Notes on Setup

This section describes setup for the software and peripheral devices. To perform setup, you must be
logged in with administrator privileges.

Also, it is recommended that setup be performed by some engineer with a certain degree of
proficiency in computers, including having an understanding of Ethernet addresses and other
terminology.

Be aware that some details may vary for different OS versions, PC display settings, and other
environments.

10—2.Network Address Settings

1) Setting the IP Address of the PC

From the Control Panel, select Network and Sharing Center, and click Change adapter
settings from the list on the left side.

@ <How to open Control Panel>
In the search box on the taskbar, type Control Panel, and then select Control Panel.

The adapters that can connect to the network are displayed. Double-click the adapter (local area
connection) that is connected to the spectrum analyzer to display its properties. Select "Internet
Protocol Version 4", and click to display the properties.

Internet Protocol Version 4 (TCP/IPv4) Properties *

Enter "192.168.99.3" for the IP address

and "255 - 255 - 255 - 0 " for th € su bn et m aSk! ‘You can get IP settings assigned automatically if your netwark supports

. this capability, Otherwise, you need to ask your network administrator
and CI |Ck OK for the appropriate IP settings.

General

This completes the IP address settings O Obtsin an [P address automatically
(®) Use the folowing IP address:

for the PC. P address:
Subnet mask:
Default gateway: l:l

Obtain DNS server address automat

(®) Use the following DNS server addresses:

Preferred DNS server: l:l

Alternate DNS server:

[ validate settings upon exit Advanced:

cancel

2) Set the IP address of the spectrum analyzer

For details on the spectrum analyzer settings, see the instruction manual for the spectrum
analyzer.

Set the IP address to "192.168.99.100" and the subnet mask to "255.255.255.0".
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10.Setup

10—3.Installing the Software

1)

Installing NI-VISA

Load the supplied DVD, and open the "NI-VISA" folder. Run Install.exe to start the installation
process. Then, perform installation by following the instructions from the installer. When installing,
make sure that the installation items include NI-VISA.

Installing the EPS-02Sv2 Software

Load the supplied DVD, and open the "EPS-02Sv2" folder.

Run EPS-02Sv2_En.msi to start the installation process. Then, perform installation by following
the instructions from the installer.

* If a previous version of EPS-02Sv2 software is already installed, uninstall it before performing
the installation.

Use of the supplied USB protect key
The supplied protect key is not required for checking the measurement data. For carrying out a
measurement by controlling the peripherals, the supplied protect key is required.

It is required to install the driver of the USB protect key before use. The driver file is in “JSP USB”
folder in the supplied setup media. After you insert the USB protect key into a USB port of the PC
where EPS-02Sv2 software in installed, open Device Manager and select “unknown devices” or
“HardKey” of “other devices” and install the driver.

The program can run a measurement only when the USB protect key is inserted into the PC. The
USB protect key can be plugged into any USB port.
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11. Specifications

11—1.Specifications

Control software, PC, and camera

ltem Specifications

Image size 640 x 480 pixels
Image division size 10, 16, 20, 32, 40, 80, or 160 pixels
Capturing type Single / Free Run / Peak Hold / Max Hold

Camera image display Still image / Video

Secondary functions | Save / Import / Export / Comment
Supported OS Windows 10/ 11

11—2.System Requirements

oS : Microsoft Windows 10 (Japanese / English version)
Microsoft Windows 11 (Japanese / English version)

CPU : Dual Core 2.4 GHz or faster recommended

Memory : 8 GB or more recommended

Storage : 5GB ormore

Display : 1366 x 768 dots or more

1920 x 1080 dots recommended

Other requirements:

® Operation cannot be guaranteed when using online storage or software that uses
cloud services.

® 2 empty USB ports

* A DVD drive is required for installation.

* If software with high CPU utilization is running, the operation may become unstable.

* Refer to the manufacturer's website for the latest operation warranty of each device such as
camera.

11—3.Supported Spectrum Analyzers

Rohde & Schwarz FSV
Rohde & Schwarz FSV3000
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12. Warranty

Repair Service Warranty

This repair service warranty applies to the repair services provided for maintaining the designated
functions and performance of NoiseKen products.

1.

Warranty Coverage
This warranty covers NoiseKen products and their accessories.

Technology and Work Fees

If a breakdown occurs in a NoiseKen product, NoiseKen will provide repair services free
of charge based on the warranty terms and conditions as long as the warranty period is
still valid. If the warrant period has expired, the customer will bear the actual costs
associated with technology and work for the repair.

Ownership of Replacement Parts

The ownership of all defective parts replaced in the course of performing the repair
belong to NoiseKen. If the repair service fees are borne by the customer, NoiseKen will
receive the replaced defective parts unless the customer specifically requests otherwise.

Limitation of Liability

If the customer incurs any damages due to the repair service or breakdown of the
NoiseKen product purchased by the customer, the liability of compensation for damages
by NoiseKen to the customer is limited to the amount paid by the customer for the
applicable NoiseKen product or the applicable non-NoiseKen product (product by other
manufacturer) only if these damages are due to the willful intent or negligence by
NoiseKen. However, for damages incurred by the customer due to the above-described
repair service provided by NoiseKen or breakdown of the applicable NoiseKen product,
under no circumstances will NoiseKen be liable for any loss of potential income occurring
directly or indirectly or any direct or indirect damages due to compensation by the
customer to a third party.

Wrong Parts, Missing Parts, or Breakage

If the product cannot be used when a wrong part, missing part, or breakage occurs in a
NoiseKen product purchased by the customer, NoiseKen will not be liable for any
damages whatsoever for losses incurred by the customer due to loss of sales or other
derived losses, special losses, or indirect or punitive damages, or any damages due to
compensation by the customer to a third party.

Decline to Repair
The company may not accept a repeair order in the following cases.
More than 5 years have passed since manufacture of a product discontinued.
More than 8 years have passed after delivery.
Required component for servicing already discontinued and no alternative is
avaaiable.
Product changed, repaired or remodeled without obtaining a prior permission from
the Company.
Product severely damaged to the extent it has lost its original form.

37




Product Warranty

For breakdowns that occur within the product warranty period, NoiseKen will repair or replace the
product free of charge. The extent and content of the repair work for the equipment will be

deter

mined by NoiseKen. This product warranty is valid in Japan only.

1. Device Coverage
This warranty covers NoiseKen products and their accessories.

2. Pro

duct Warranty Period

This warranty is for one year starting from the delivery date of the product.

If the same breakdown at the same location is repaired, the warranty period is six
months from the date that the repair was completed.

For non-NoiseKen products, the product warranty of the supplier (manufacturer) applies.

3. Exceptions
Regardless of the above stipulations, the warranty does not cover breakdowns due to one of

the

<%

R T R S S

following.

Replacement of consumable parts, including the replacement (for used products) of
mercury relays, high-voltage relays, coaxial cords, coaxial connectors, automatic
switchers, contactors, and other consumables

Damage or breakdowns that occurred due to failure to follow proper operating
procedures.

Product failures resulting from damage or breakdowns due to modifications not
involving NoiseKen

Product failures resulting from damage or breakdowns that occurred when someone
unauthorized by NoiseKen attempted to perform repairs

Product failures resulting from damage or breakdowns caused directly or indirectly by
natural disasters, war, riots, civil strife, or other force majeure

Product failures resulting from damage or breakdowns caused by transportation,
vibrations, dropping, impact, or other misuse after delivery

Product failures resulting from damage or breakdowns caused by the usage
environment

When the customer takes the product outside Japan
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Software Warranty

A warranty is provided for the software produced by NoiseKen and its update files under the
following terms and conditions. This warranty is valid in Japan only.

1. Scope of Warranty
This warranty applies to the software produced by NoiseKen and its update files.

2. Free Support
If a fault occurs in the system as a result of this software by NoiseKen, NoiseKen will
provide support free of charge through software fixes and updates or other means only
within the warranty period. However, please be aware that we may discuss when to
implement corrective measures for minor issues.

3. Total Maximum Liability

If the customer incurs losses or damages due to a fault of this NoiseKen software
purchased by the customer, unless the losses or damages are the result of willful or
negligent actions, the maximum amount of NoiseKen’s liability for compensation for
these losses or damages to the customer is equal to the amount that the customer paid
for this NoiseKen software. But, NoiseKen assumes no liability for any losses or
damages incurred by the customer due to faults arising from this software by NoiseKen,
including but not limited to, direct or indirect potential lost earnings and direct or indirect
damages due to third party claims for compensation against the customer.

4. Warranty Period
The warranty period is the support period of the OS by the provider (including extended
support periods) for the OS where operation is guaranteed by NoiseKen. When the
support period of this OS ends, support for this software in this OS will also come to an
end.
The after service of the software ends support when the production and sales of the
specific control equipment are discontinued.

5. Exclusions
These terms and conditions do not constitute a full and complete guarantee of operation
or compatibility with the customer’s system. Also, the following situations are outside the
scope of support.
[Combining with products]
Although every effort will be made to provide comprehensive software support, in
combination with products other than those recommended by NoiseKen, some faults
may be unable to be resolved due to lack of compatibility or conflicts with PCs,
peripherals, and other hardware, and OS and other software. In addition, even in
combination with products recommended by NoiseKen, faults may be unable to be
resolved due to serious defects occurring in the recommended products.
[Added functions and OS upgrades]
Please note that support for added functions and OS upgrades are outside the scope of
free support.
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13.NOISE LABORATORY SUPPORT NETWORK

® |f a symptom which seems a trouble is found, check the symptom, software version,
model name of connected device, and serial number, and inform this information to

Noise Laboratory or your nearest sales agent of Noise Laboratory.
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Note

41



NOISE LABORATORY CO., LTD.
1-4-4, Chiyoda, Chuo-ku, Sagamihara City, Kanagawa Pref., 252-0237, Japan
TEL: +81-(0)42-712-2051  FAX: +81-(0)42-712-2050

URL: http://www.noiseken.co.jp
Printed in Japan



